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ERACS Enhancements (Windows Version)
The following list describes the enhancements made to ERACS in each Windows version that has been released.

Version 3.9.8 - Released 31/08/17
UPDATED REFERENCE LIBRARY
Added the following Merlin Gerin moulded-case circuit breakers (MCCBs) and ST204S trip unit: Compact C400H &
C630H.
UPDATED REFERENCE LIBRARY
Added a model that represents the GE Record Plus FD160H moulded-case circuit breaker. It has been associated with
the following trip units...
GTM: 25, 32, 40, 50, 63, 80, 100, 125 & 160A.
LTM: 16, 20, 25, 32, 40, 50, 63, 80, 100, 125 & 160A.
LTMD: 16, 20, 25, 32, 40, 50, 63, 80, 100, 125& 160A.
Mag Break: 3, 7, 12.5, 20, 30, 50, 80 & 100A.

HARMONIC SURVEY
The harmonic survey report has been improved so that busbars which are not energised are clearly highlighted and
include a hint
UPDATED REFERENCE LIBRARY
Added relay models to represent the instantaneous and inverse time functions of the GE F650 relay
F650_G_1: represents the ground overcurrent 51 & 50 function. 1 Amp relay.
F650_G_5: represents the ground overcurrent 51 & 50 function. 5 Amp relay.
F650_P_1: represents the phase overcurrent 51H, 51L, 50H, 50L & 63 function. 1 Amp relay.
F650_P_5: represents the phase overcurrent 51H, 51L, 50H, 50L & 63 function. 5 Amp relay
UPDATED REFERENCE LIBRARY
Added relay models that represent the phase and ground functions of the GE 489 generator management relay.
UPDATED REFERENCE LIBRARY
Added overcurrent and earth fault models of the ABB Relion (RET, FEF & REM) 630 series relay.
UPDATED REFERENCE LIBRARY
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Added models representing the overcurrent and earth fault functions of the following Areva K Range Series 2 relaysâ€¦
KCGG 122, 142.
KCEG 112, 142, 152, 242.
KCEU 142, 242.

UPDATED REFERENCE LIBRARY
Added the following ABB circuit breaker and trip unitsâ€¦
SACE Tmax LV moulded-case circuit breaker T7H 1250 A.
PR331/P LSIG trip unit.
PR332/P LSIG trip unit.

UPDATED REFERENCE LIBRARY
Added the following Schneider Electric vacuum circuit breakers and trip unitâ€¦
Premset D06N vacuum circuit breaker.
Premset D06H vacuum circuit breaker.
VIP 400/410 trip unit.

UPDATED REFERENCE LIBRARY
Added relays that represent the following functions from the GE M60 motor protection relay: 50P, 67P and 51G/50G.
UPDATED REFERENCE LIBRARY
Added the following ABB air circuit breakers and trip unitsâ€¦
SACE Emax 2 E1.2N 1600 air circuit breaker.
SACE Emax 2 E4.2N 3200 air circuit breaker.
Ekip Touch LSIG trip unit.
Ekip Dip trip unit.

UPDATED REFERENCE LIBRARY
Added a model that represents the GE Record Plus FE250H moulded-case circuit breaker. It has been associated with
the following trip unitsâ€¦
GTM: 125, 160, 200 & 250A.
LTM: 125, 160, 200 & 250A.
LTMD: 125, 160, 200 & 250A.
Mag Break: 160, 200 & 250A.

UPDATED REFERENCE LIBRARY
Added relays that represent the back-up functions of the Areva MiCOM P632 relayâ€¦
phase current DTOC function.
residual current DTOC function.
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phase current IDMT function.
residual current IDMT function.

UPDATED REFERENCE LIBRARY
Added Schneider Electric Compact NSX250H moulded-case circuit breaker and Micrologic 2.2 trip unit. Also, the
Micrologic 2.2 trip unit has been associated with the existing NSX250L, NSX160H and NSX100H moulded-case circuit
breakers.

PROTECTION COORDINATION GRAPH
A feature has now been included that enables the background colour for text to be defined.
PROTECTION COORDINATION GRAPH
The protection graph now shows the current line associated with a discrimination box. These lines, known as
discrimination lines, are provided via a right-click menu with these items..."Discrimination Line", "Edit Details", "Remove
Discrimination Box" and "Hide/Show Information Box".
VECTOR DIAGRAM
A facility has been provided that enables a vector diagram, showing fault current and the currents that contribute to it,
to be drawn in an Excel report.
PHASOR DIAGRAM
A facility has been provided that enables a phasor diagram, illustrating the phase, sequence and residual quantities of
current and voltage, to be drawn in an Excel report.
UPDATED REFERENCE LIBRARY
Added Schneider Electric Compact NSX400N moulded-case circuit breaker and Acti 9 iC60 B, C & D miniature circuit
breakers.
PAN TOOL
A pan tool has been included in the ERACS single-line diagram and UDM simulation. The pan tool is enabled via a "Pan"
option that has been included in the "View" menu or via a toolbar button. When the pan tool is enabled, moving the
mouse while keeping the left mouse button depressed will cause the single-line diagram to move in the same direction.
DIAGRAM NAVIGATION
A GoTo option has been included in a transformer's right-click popup menu that enables you to easily navigate to the
busbars the transformer is connected to and to locate the transformer symbol.
DIAGRAM NAVIGATION
A GoTo option has been included in the right-click popup menu of cable, transmission line and series elements that
enables you to easily navigate to the busbars the element is connected to.
UPDATED REFERENCE LIBRARY
Added ABB SACE Tmax XT2H 160 moulded-case circuit breaker and range (40, 50, 63, 80, 100, 125 & 160 A) of TMA
thermo-magnetic trip units.
UPDATED REFERENCE LIBRARY
Added ABB SACE Tmax T2H 160H moulded-case circuit breaker and PR221DS/GP trip units.
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UPDATED REFERENCE LIBRARY
Added ABB SACE Tmax XT3N 250 moulded-case circuit breaker and range (63, 80, 100, 125, 160, 200 & 250 A) of TMD
thermo-magnetic trip units.
UPDATED REFERENCE LIBRARY
Added ABB SACE Tmax T4H 250 moulded-case circuit breaker and PR221DS trip unit.
UPDATED REFERENCE LIBRARY
Added Eaton series NRX type IZMX16 & IZMX40 air circuit breakers and corresponding Digitrip trip units - IZMX-DTA,
IZMX-DTP, IZMX-DTP-G, IZMX-DTP-I, IZMX-DTU, IZMX-DTV, IZMX-DTV(U)G.
UPDATED REFERENCE LIBRARY
Added ABB SACE Tmax T5S 630 moulded-case circuit breaker and PR221DS, PR222DS, PR223DS trip units.
UPDATED REFERENCE LIBRARY
Added ABB SACE Tmax XT4S160 & XT4S250 moulded-case circuit breakers and Ekip LI, LS, LSIG trip units.
TRANSIENT STABILITY GRAPH
We have added a facility that enables you to export your Transient Stability graph to an Excel report that shows two
graphs: one similar to that provided by Transient Stability and a second that allows you to select an individual plot
parameter.
RELAY & CIRCUIT BREAKER TRIP UNITS
The current and time setting controls have been modified such that when they display the unit label ("A" or "s"), one is
able to modify the setting value by typing an appropriate value in the control.
UPDATED REFERENCE LIBRARY
Added DRIESCHER type STA HV fuse families.
UPDATED REFERENCE LIBRARY
Added relays representing Siemens Argus 7SR224 directional overcurrent and earth fault functions.
SHARE MY DIAGRAM
The Share My Diagram facility allows you to easily and conveniently share your ERACS single-line diagrams with
selected people via the internet. The resulting diagrams can be visualised and interrogated without a copy of ERACS
and instead, using your favourite web browser.
TUTORIAL 1 MANUAL
The "Tutorial 1" manual has been updated to reflect new screen layouts and features.
TECHNICAL MANUAL
The technical manual has been updated and now includes sections describing the Arc Flash Risk Assessment module.

Version 3.9.7 - Released 14/07/16
UPDATED REFERENCE LIBRARY
Added overcurrent and earth fault models of ABB's Relion (RET, REF & REM) 620 series relay.
ERACS COMMON INTERFACE
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The ERACS common interface has been updated so that it now supports text items.
UPDATED REFERENCE LIBRARY
Added overcurrent and earth fault models of Fanox's SIA-C relay.
PROTECTION COORDINATION REACTANCE SELECTION
Facilities have been included that enable you to define the default value that for the protection co-ordination reactance
selection. This is achieved by selecting "Program Options" from the "Tools" menu and then the "General" page. A
dropdown list has been provided that allows the default value to be selected.
TRANSFORMER IMPEDANCE UNITS
The default option for transformer "Impedance Units" has been updated from "pu on rating" to "% on rating".
UPDATED REFERENCE LIBRARY
Overcurrent and earth fault models of Schneider Electric's Sepam 20, 40 & 80 series relays configured with time delay in
"TMS mode" have been added to our reference library.
ARC FLASH RISK ASSESSMENT MODULE
The Arc Flash Risk Assessment module has been updated in-line with the latest 2015 edition of NFPA 70E, Standard for
Electrical Safety in the Workplace.
PROTECTION DEVICES
We have made it much simpler to attach protection devices to a cable and transmission line. As well as selecting the
point at which the cable attaches to a busbar, one is now able to select items that are attached to a cable.
LOADFLOW VOLTAGE CONTROL
Synchronous machines have been provided with an option that enables them to control the voltage at a remote busbar
(i.e. a busbar that they are not connected to) during Loadflow studies.
Please view the associated demo movie for further information.
EXPORT FACILITIES
Four new export formats have been added:
1) PDF document (*.pdf).
2) Scalable vector graphics (*.svg): this method produces an interactive diagram that is viewable in most web browsers.
The resulting SVG file can be given to your clients who will be able to view and interact with the diagram as well.
3) Web formatted data table (*.htm): produces a tabular representation of your network data, viewable in most web
browsers.
4) XML document (*.xml): produces a hierarchical description of your network data, which is viewable in most web
browsers and text editors.
Access to the existing export formats (*.bmp, *.emf, *.csv and *.jpg) has been made much simpler, where we have
provide three ways to access the facilities:
- Select "Export As" from the "File" menu.
- Select "Export As" from the diagrams right click popup menu.
- Click the speed button that has been included in the toolbar.
Please view the associated demo movie for further information.
UPDATED REFERENCE LIBRARY
Added Cooper Bussmann fuses; NH Series Class gG/gL, 690Vac, 2 to 800 Amps, Sizes 000 to 4.
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UNIVERSAL DYNAMIC MODELLER
A new block has been added that enables a 2D lookup table to be defined. The purpose of the 2D lookup table is to
provide an approximation to a function of the form Z = f(X,Y), using a lookup table method.
LIBRARY EXPORT FACILITIES
Two new library export formats have been provided...
1) Web formatted data table: this method presents the selected library data in a tabular format, which may be viewed
in any web browser.
2) XML document: this method will export the library data using XML (Extensible Markup Language), which can be
viewed in most web browsers and programs that can read text based files.
ERACS COMMON INTERFACE
The ERACS common interface now includes the following network properties...
- Appearance settings.
- Result settings.
- Voltage Levels: colours & thresholds.
PROTECTION COORDINATION GRAPH
A facility has been added that enables you to adjust the width of the lines used to represent the electrical current value
for fault lines, load lines and discrimination lines. To adjust the line width select "Program Options" from the "Tools"
menu and the new control is provided on the "Appearance" page and is named "Width for Fault Line, Load Line and
Discrimination Line".
PROTECTION COORDINATION GRAPH
An option called "Highlight Device in Single-line" has been added to the popup menu displayed when you right-click a
curve. When that option is selected the single-line diagram focus is moved to the area containing the selected device,
the device is highlighted and if necessary the setting graph is moved to one side.
UNIVERSAL DYNAMIC MODELLER
Facilities have been provided that enable you to display a symbol at the start, end and join of a connection. This makes
it much easier to identify the direction of signal flow and where joints in connections occur. To change the symbols,
select Tools>User Options>Connections.
UPDATED REFERENCE LIBRARY
Added the following Schneider Electric moulded case circuit breakers (MCCBs) and trip units...
- MCCBs: NSX100H, NSX160H, NSX250L, NSX400H & NSX630H.
- Micrologic Trip Units: 2.3, 5.2, 5.3, 6.2 & 6.3
INDUCTION MACHINE PARAMETER CALCULATOR
The help system has been updated and converted to PDF format. Access to the resulting document is provided from
within the calculator.
HARMONIC IMPEDANCE MODULE
It is now possible to perform a harmonic impedance survey, where ERACS will calculate the harmonic driving point
impedance at every busbar in your single-line. Facilities are provided to display impedance curves and export the driving
point impedance values for analysis outside of ERACS.
UPDATED REFERENCE LIBRARY
Added the following Lawson fuses: types: MES, NS, J, N&T, SS, semiconductor and motor circuit.
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Version 3.9.6 - Released 13/04/15
UPDATED REFERENCE LIBRARY
Added models of the Merlin Gerin Masterpact low voltage air circuit breakers MP08 to MP63, together with a range of
associated trip units.
UPDATED REFERENCE LIBRARY
Added models of Alstom's CTZ66/CTZ76 relays.
UPDATED REFERENCE LIBRARY
Added relay models of...
- Strike Technologies: FP04 FP2000.
- ABB: RET541, RET543, RET545 & REJ525.
UPDATED REFERENCE LIBRARY
A model of the P&B MRI (Mk3) protection relay has been included.
RENAMING STUDIES
It is now possible to rename a study by using the rename facilities provided in the Database Explorer.
UPDATED REFERENCE LIBRARY
Improved the following relay modelsÃ¢â‚¬Â¦
Reyrolle TJV & TJEV - changed the time multiplier increment from 0.1 to 0.05.
Areva MCGG22 - can now be selected for earth fault protection.
PROTECTION, HARMONIC IMPEDANCE & TRANSIENT GRAPHS
Two buttons have been included in the toolbar of each of these windows. The buttons enable one to copy the graph
and the window to the clipboard as an image that can then be pasted into a document of another application; e.g.
Microsoft Word.
UPDATED REFERENCE LIBRARY
The following fuse families have been included in the Reference Library:
Brush MJ, PJ, RJ series 63A to 630A.
Lawson LV type J 20A to 630A.

UNIVERSAL DYNAMIC MODELLER
A new block that implements the rectifier regulation function as per Annex D of IEEE Std 421.5-2005 has been included
in the Universal Dynamic Modeller.
PROTECTION GRAPH INFORMATION BOXES
Facilities have been provided that enable you to select whether the text in the information box is shown in black or
adopts the colour of the curve it represents.
UNIVERSAL DYNAMIC MODELLER
A deadband block has been included in the Universal Dynamic Modeller.
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AVR & GOVERNOR SIMULATIONS
Facilities have been provided that enable AVRs and governors to pickup signals from busbars and branches that are
remote from the synchronous machine they are associated with. This is the list of new input signals that are available to
AVRs and governors:
Sensed Busbar Voltage Magnitude (pu)
Sensed Busbar Voltage Angle (rad)
Sensed Busbar Voltage Angle (deg)
Sensed Busbar Real Voltage (pu)
Sensed Busbar Reactive Voltage (pu)
Sensed Busbar Frequency (pu)
Branch Real Power (MW)
Branch Real Power (pu)
Branch Reactive Power (MVAr)
Branch Reactive Power (pu)
Branch Current Magnitude (kA)
Branch Current Magnitude (pu)
Branch Current Angle (rad)
Branch Current Angle (deg)
Branch Power Factor

COPY EXISTING STUDY WINDOW
The Copy Existing Study window has been improved so that one is able to select whether the studies for all data states
are displayed. This greatly reduces the information presented and makes it much easier to select studies:
- A "Show studies from all data states" tick box has been added to the window.
- When "Show studies from all data states" is not ticked...
-- the list presents only those studies performed in the current data state.
- When "Show studies from all data states" is ticked...
-- All studies from all data states are presented in the list.
-- The list includes both "Study Name" and "Data State Name".
-- The studies from different data states are displayed differently.
NETWORK PROPERTIES
The library selection facilities that are provided when ERACS is unable to locate one of the network libraries has been
made available via the Network Properties form.
UPDATED REFERENCE LIBRARY
Models for Susol TS100N and TS400N have been created, together with FTU, FMU, ETM & ETS trip units.
UPDATED REFERENCE LIBRARY
Added the ABB SACE Emax E3V 1600A LV air circuit breaker and associated PR121, PR122 & PR123 trip units.
UPDATED REFERENCE LIBRARY
Added model of the Schneider Electric MiCOM P116 protection relay.
UPDATED REFERENCE LIBRARY
Added overcurrent and earth fault models of the Siemens 7SR11 & 7SR12 protection relays.
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UPDATED REFERENCE LIBRARY
Added the following ABB circuit breakers and trip units to the Reference Library...
SACE Circuit Breakers...
Emax LV air circuit breaker E1N 1250A.
Tmax LV moulded-case circuit breaker T4N
Tmax LV moulded-case circuit breaker T4N
Tmax LV moulded-case circuit breaker T5N
Tmax LV moulded-case circuit breaker T5N
Tmax LV moulded-case circuit breaker T6N
Tmax LV moulded-case circuit breaker T6N
Tmax LV moulded-case circuit breaker T6N
Tmax LV moulded-case circuit breaker T7N

250A.
320A.
400A.
630A.
630A.
800A.
1000A.
1600A.

Trip Units...
PR222DS/P LSIG.
PR223DS LSIG.
PR332 LSIG.

UPDATED REFERENCE LIBRARY
Added models to represent the overcurrent and earth fault units of the ABB SPAD 346 C protection relay.
PV-TYPE GENERATORS
A facility has been included in the Loadflow Parameters that enables one to select whether the target voltage of a
PV-type generator is employed when such a machine is converted to a slack generator.
UPDATED REFERENCE LIBRARY
Updated Siemens 7SJ602 earth fault and overcurrent models, removed the dedicated stage that represented the low set
DT curve and combined the DT curve in the same stage as the IDMT curves.
UPDATED REFERENCE LIBRARY
Added models to represent the short circuit and ground fault functions of the GE Multilin 369 motor management relay.
FIND ELEMENT WINDOW
The list of elements displayed in the Find Element window now employs a "Natural" text comparison, which means that,
for example, these busbars...
BUS_2
BUS_12
BUS_1
Would be sorted like this...
BUS_1
BUS_2
BUS_12
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Rather than this...
BUS_1
BUS_12
BUS_2

UPDATED REFERENCE LIBRARY
A number of CDG X1/X6 5A relays (X = 1,2,3) have been included in the Reference Library.
LIBRARY SELECTION
The library selection facility for an existing network has been made more flexible and allows a library to be selected
more easily from a new location.
HARMONIC IMPEDANCE MODULE
The harmonic impedance module has been updated to provide facilities to export the following items to a
comma-separated values (CSV) file...

the harmonic impedance angle values.
the harmonic impedance magnitude values.
the harmonic transfer coefficient (magnitude of harmonic impedance / driving point impedance).

Please note that we have used the term "harmonic impedance" to mean the driving point impedance for the injection
busbar and the transfer impedance for all other busbars.
LOADFLOW EXCEL REPORTS
The Loadflow Excel reports have been updated so that they support 64-bit editions of Microsoft Excel.
PDF EXPORT FACILITY
A PDF export facility has been included for the following graphs...
harmonic impedance
harmonic waveforms
transient stability
protection co-ordination
PROTECTION GRAPH IMAGE BOXES
Facilities have been provided that enable you to include an image in your protection graph. That image supports
bitmaps, metafiles & JPGs and can be used to display a section of your single-line diagram or a company logo, for
example.

Version 3.9.5 - Released 27/03/14
LIBRARY MEMO FIELD
The library memo field has been made more accessible and is now contained within the library data entry form, in its
own tabbed page.
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EXPORT TO STANDALONE ARC FLASH HAZARD CALCULATOR
A facility has been added to the Arc Flash Hazard Report (i.e. the results form shown after running an Arc Flash Hazard
Assessment) to export the study into a format that can be imported into the standalone Arc Flash Hazard Calculator.
NETWORK PROPERTY FOR ARC FLASH UNITS
It is now possible to select Arc Flash Units (metric or imperial) as a property of a Network. This impacts the units used
for distance- and energy-related fields during study setup and when viewing results within an Arc Flash Hazard study.
FAULT TYPE INDICATION IN SUMMARY RESULTS
A new result option has been provided that enables you to select and then display a brief description of the fault type in
the summary results box that is shown on the network diagram.
3000 BUSBAR VERSION
ERACS now supports up to 3000 busbars. Please contact the ERACS Team should you require this option.
NEW PROTECTION SETTING REPORT
It is now possible to create a protection setting report without having to run a protection study. The new facility enables
multiple protection setting reports to be created. One is able to select whether the report contains all protection devices
or just a subset. The report presents the devices in a tabular format and groups the devices by switchboard (busbar)
and circuit (element to which the device is attached or adjacent switch). The table of setting can be opened in Microsoft
Word with a single click and can also be exported to various formats, including PDF.
NEW LOADFLOW RESULT FOR MACHINES - PERCENTAGE KA LOADING
We have included "Percentage kA Loading (%)" as a displayable result for synchronous and induction machines. The
value is calculated as the ratio, expressed as a percentage, of the current delivered by the machine to the rated current
of the machine. The rated current is determined using the machine's rated MVA and rated kV.
NETWORK OVERVIEW WINDOW - CURSOR STYLE OPTION
An option has been added to the popup menu of the Network Overview window that enables the style of the mouse
cursor that appears when the mouse is placed over the viewport to be selected. Two options have been provided: Arrow
and Hand.
ABB PR512/P RELAY ADDED
The ABB PR512/P overcurrent and earth fault relay has been added to the ERACS Reference Library.
MECHANICAL LOAD LIBRARY ENTRIES IMPROVED
The mechanical load entries in the ERACS Reference Library have been rationalised, improving the key names and
descriptions.
NETWORK OVERVIEW WINDOW - IMPROVED NAVIGATION FOR LARGE NETWORKS
Use of the network overview window to navigate large networks has been improved, especially where the network is so
large that the current viewport is difficult to locate. One can now set the network diagram viewport by either
double-clicking or clicking the mouse wheel at the desired location in the network overview window.
NEW BUSBAR VOLTAGE PROFILE REPORT IN TRANSIENT STABILITY
Following a Transient Stability calculation, a busbar voltage profile report can be generated. This report displays the
identifier, description, rated kV, Loadflow kV, Transient kV and voltage difference for every busbar in the network,
following a Transient Stability calculation. The voltage profile report is accessed via a new button that has been included
on the Transient Stability graph window or via a new option in the Results menu.
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WEB ACCESS SECURITY SOLUTION GUIDE
A web access security solution guide has been produced and an option to access the guide has been added to the
Manuals sub-menu in the Help menu.
WEB ACCESS SECURITY FAILOVER
Following an outage with our web access security solution, we have provided a software failover facility that enables
ERACS to switch from our main web access server to a replicated failover server. This modification should provide a
more robust and reliable security solution.
ARC FLASH LABELS - EUROPEAN AND AMERICAN FORMATS AVAILABLE
A "Label Format" facility has been added to enable generation of European or American arc flash hazard warning labels
from within an Arc Flash Hazard study.

Version 3.9.4 - Released 23/04/13
NEW FEATURE: USER-DEFINED FIELDS
We have included a facility that enables you to add up to 10 user-defined fields (UDFs) to each type of element that
ERACS represents.
Three different types of field have been allowed - integer number, floating point number and string. These UDFs are
defined via the Network Properties window and are then accessible for data entry in the element data entry forms.
The UDFs can be displayed, along with element data, on the single-line diagram and are also included in the element
data printout.
ENHANCEMENT TO PROTECTION MODULE TO LIST ISOLATED BUSBARS
We have modified the protection module to produce a list of busbars that have been isolated by a study.
The list includes the busbar's name, description, rated voltage and any user-defined fields that have been associated
with busbars.
Facilities are provided to print and export the list to Microsoft Word, a spreadsheet and other formats (HTML, XML,
JSON & CSV).
PUBLISHING PROTECTION ANALYSER RESULTS TABLE
A facility has been included that enables the protection analyser results table to be published to Microsoft Word using
two alternative templates.
The first template, known as "Standard", includes a table that is a direct replica of that presented in the results window.
The second template, known as "Standard, plus an empty 'User Comment' column", has all of the columns provided by
the "Standard" template and an empty column that is labelled "User Comment".
ERACS CAN NOW CHECK IF A NEW UPDATE IS AVAILABLE.
A facility has been included that enables ERACS to check whether a new update is available. On starting, ERACS will
now check whether an update is available and if it is will provide you with controls to download the update and view the
update history.
You can control whether you want the update check to be performed and its regularity by using the controls available
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via Tools|Options|General.
UPDATED REFERENCE LIBRARY
We have added the ABB REJ603 overcurrent and earth fault relay.
IMPROVED FEEDBACK FOR RELAY DIRECTIONAL INDICATOR
The hard copy reports for a directional indicator have been made more informative. Rather than simply stating "No" and
"Yes", one of the following values is displayed "Non Directional", "Into Element" or "Out of Element".
UPDATED TUTORIAL MANUALS
Both tutorial manuals have been updated to reflect the latest ERACS screens and procedures.
OPTION TO EXPORT STUDY LISTING TO MICROSOFT WORD
A facility has been included that enables a study listing to be exported to Microsoft Word. This option is available after
you have run a study, by selecting "View Data / Results Listing" from the Results menu.
The study listing window will be shown. If you have Microsoft Word installed, the Word toolbar button will be enabled.
Click the Word toolbar button to reveal the "Send Study Listing to Microsoft Word" window. This will permit you to
export the listing to a Word template provided by ERACS or insert the listing into a selected Word document.
UPDATED REFERENCE LIBRARY
We have replaced the Reyrolle TJX form 3/10 models with models that also include the 4/20, 9/6 and 30/5 forms.
ENHANCEMENT TO INCLUDE REACTANCE SELECTION
Fault, Protection and Arc Flash: A facility has been included that enables you to apply the reactance selection to
synchronous machines that have been configured as 'Voltage Behind an Impedance' and their library key includes Park's
data.
Transient: An option has been provided that enables you to select the reactance that should be employed by
synchronous machines that have been configured as 'Voltage Behind an Impedance' and their library key includes Park's
data.
CONFIGURATION CHANGE
The controls used to configure the location of the ERACS working folder have been removed from the Tools|Options
window.
The working folder is used by ERACS to store its temporary files and all Paradox files. These files are deleted when
ERACS closes. Allowing the location of the working folder to be changed is potentially dangerous, since a folder that
contains ERACS databases or, worse still, a folder that contains Paradox files belonging to another package could be
chosen.
IMPROVED FEEDBACK AFTER A STUDY IS DELETED
When the study information is deleted, the progress bar caption has been improved, providing a more informative and
reassuring message.
ERACS REFERENCE LIBRARY
The minimum current setting multiple for the IEC curves of the MCGG relays has been reduced from 2 to 1.1

Version 3.9.3 - Released 24/09/12
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UPDATED REFERENCE LIBRARY
We have added the following Areva MiCOM P124 & P14x relays to the Library.
BUSBAR FAULT RATING CHANGE
The default fault rating for 415 V busbars has been changed from 31 MVA to the more commonly used 36 MVA rating.
ARC FLASH HAZARD MODULE
The units used within the Arc Flash Hazard module for displaying distance-related items have been improved. Metric
distances above 100mm will now be displayed in metres and imperial distances over 12 inches will be shown in feet and
inches.
ARC FLASH HAZARD MODULE
The Arc Flash Hazard module has been updated in line with IEEE Std 1584b-2011.
A new option now exists to allow a maximum clearance time of 2 seconds to be employed for all locations in a study (as
per section 4.6 paragraph 1).
TEXT BOX MOVED IN LOADFLOW EXCEL REPORT
In the "Voltage Profile" Loadflow Excel Report, the position of the text box (which provides general guidance) has been
changed for all charts to the bottom-right of the chart rather than the top-right as previously.
UPDATED REFERENCE LIBRARY
We have added the following Dorman Smith E-Frame MCCBs : 1600A, 2000A, 2500A & 3200A, and Teresaki MCCBs :
XS400CJ & XS400NJ to the reference library
UPDATED REFERENCE LIBRARY
We have added the Terasaki AT20 ACB plus AOR-1BL-GS trip unit and the ABB trip unit: PR112 to the reference library.
UPDATED REFERENCE LIBRARY
We have added the P+B Engineering PBSJ120 relay and CEE relays: ITG7266, ITG7366, ITG7466 & ITG7566 to the
Library.
UPDATED REFERENCE LIBRARY
We have added the VIP201 relay model and associated it with the SF6 circuit breaker.
UPDATED REFERENCE LIBRARY
We have added the following Areva overcurrent and earth fault relays to the library: MiCOM P126 & P127.

UPDATED REFERENCE LIBRARY
We have added the Reyrolle 2TJM70 relay to the Library.
UPDATED REFERENCE LIBRARY
We have updated the existing GEC CDG11, 21 & 31 (3 secs) relay models and have addded the GEC CDG11, 21 & 31
(1.3 secs) relay models to the library.
UPDATED REFERENCE LIBRARY
We have added the range of Siemens Sentron 3WL ACBs to the reference library, including the following trip units:
ETU15B, ETU25B & ETU45B.
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ARC FLASH HAZARD MODULE
The Arc Flash Hazard module has been updated in-line with the latest 2012 edition of NFPA 70E Standard for Electrical
Safety in the Workplace.
ABILITY TO VIEW THE KEY LIBRARY LIST IN MORE DETAIL
The ability to show the library key list view in more detail.
When selected, the following columns are displayed: "Created By", "Date Created", "Modified By" & "Date Modified".
The list can be sorted by any of those new columns, by simply left-clicking in the column header. To display these new
columns right-click the list view and select "Show Details" from the menu.
THE DATABASE ZIP FACILITY
The Database Zip facility has been improved and provides a method for you to send your zip archive to any email
address, rather than just ERACS.

Version 3.9.2 - Released 15/09/11
UPDATED REFERENCE LIBRARY
We have added the GEC CAG12 relay to the reference library.
UPDATED REFERENCE LIBRARY
We have added the Areva P342/P343 relay to the reference library.
UPDATED REFERENCE LIBRARY
We have added the following GE Power Controls fuses to the reference library: KEBXO, KEMXO, KFBXO, KFMXO, KSBXO,
KSMXO and KTMXO.
DATABASE HISTORY LIST
We have increased the number of items displayed in the list of previously opened databases, which is presented in the
Database menu, from 9 to 12.
UPDATED REFERENCE LIBRARY
We have added the Areva MiCOM P341 relay to the reference library.
UPDATED REFERENCE LIBRARY
We have added the following Terasaki circuit breakers to the reference library: S400NE, S630NE, AR208S, AR212S,
AR220S, AR325S, AR332S, AR440S, AR650S & AR663S.
PROTECTION LINKS
A single circuit breaker can now accept an unlimited number of links from protection relays.
WINDING ANGLE FOR STAR CONNECTION
The winding angle for star connected windings can now be set to +7.5 degrees and -7.5 degrees, which enables
24-pulse transformer-rectifiers to be simulated.
OVERLOADED EMBEDDED ELEMENTS
We have modified the Loadflow calculation so that when it detects that an embedded element is overloaded, the host of
the embedded element is highlighted on the single-line diagram.
UPDATED REFERENCE LIBRARY
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We have included the following Schneider circuit breakers (RN2c, RNE2c, CN2, CE2, RN6c), together with integral VIP
relays (VIP 300, VIP 200, VIP 35 & VIP 30) and time fuse links in the reference library. In order to implement the VIP
relay, we have enhanced the relay and trip unit modelling facilities so that the following options are available: current
settings can be displayed in amperes (based on selected rating) instead of multiples of rating/pickup; and, the time
setting can be displayed as a time delay in seconds.
UPDATED REFERENCE LIBRARY
We have added the following relays to the reference library: Reyrolle TJX; Metropolitan-Vickers PBO and NPO

Version 3.9.1 - Released 14/04/11
UPDATED REFERENCE LIBRARY
We have replaced the Areva MCGG relays by equivalent relays that include the instantaneous element. Please note that
the instantaneous element has been approximated by a definite time characteristic with an operating time of 20 ms.
UPDATED REFERENCE LIBRARY
We have replaced the AREVA K series relays by equivalent relays that combine all stages into a single device.
ARC FLASH HAZARD MODULE
The Arc Flash Hazard module has been updated in-line with the latest 2009 edition of NFPA 70E - Standard for Electrical
Safety in the Workplace.
ARC FLASH HAZARD RESULTS
The Incident Energy (cal/cm^2) calculated by our Arc Flash Hazard module can now be displayed on the single-line
diagram. In addition to this, alternative units can now be selected for displaying Arc Flash Hazard study data and
results.
RESULTS PRECISION
A control has been added to the results selection form that allows you to specify the number of decimal places the
results should be rounded to for the currently open network. This selection is then saved with the network properties,
which means that the selection persists between ERACS sessions.
INCIDENT ENERGY DISSIPATION GRAPH
A graph showing Incident Energy (y-axis) against Working Distance (x-axis) with Hazard / Risk Categories (HRCs)
overlaid is now available in the Arc Flash Hazard module. Additionally, a two-way calculator to calculate working
distance from incident energy and vice versa has been included alongside the graph, as has a table comprising HRCs,
their corresponding incident energy values and associated working distances.
ARC FLASH HAZARD WARNING LABELS
It is now possible to publish working distances corresponding to each Hazard / Risk Category (HRC) in Arc Flash Hazard
Warning Labels.
BUSBAR TOOLBAR
A busbar toolbar has been provided, which enables vertically-orientated and square busbars, as well as the existing
horizontal busbars to be added to your single-line diagrams.
ERACS WEB ACCESS MANAGER (EWAM)
A facility has been provided that enables licences that have not been active for the last 60 minutes to be "unlocked" and
made available for other users.
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MULTI-STAGE PROTECTION DEVICE
The library data entry form for multi-stage protection devices has been improved and enables curves and stages to be
copied and pasted.
UPDATED REFERENCE LIBRARY
We have added the following MiCOM relays to the reference library: P120, P121, P122, P123.
UPDATED REFERENCE LIBRARY
We have added the following Alstom relays to the reference library: CTZ61/71 & CTZ62/72.
UPDATED REFERENCE LIBRARY
We have added the following Schneider relays to the reference library: Sepam series 10, Sepam series 20, Sepam series
40 & Sepam series 80.
NETWORK PROPERTIES
We have included results font information in the network properties. This means that the results font selection will
travel with your network diagram.
UPDATED REFERENCE LIBRARY
We have added the following ABB trip units to the reference library: PR121/P, PR122/P & PR123/P.
UPDATED REFERENCE LIBRARY
We have added the following Merlin Gerin (Schneider) air circuit breakers to the reference library: M08-M63 and their
corresponding trip units: STR18M, STR28D, STR38S & STR58U.
UNIVERSAL DYNAMIC MODELLER
The following input signals have been included for DFIG, controlled shunt and wind turbine simulations: "Terminal Real
Power (pu)", "Terminal Reactive Power (pu)", "Terminal Current Magnitude (pu)" and "Terminal Current Angle (rad)".
MULTI-STAGE PROTECTION DEVICE
The multi-stage protection device model has been improved and now supports up to 10 stages.
UPDATED REFERENCE LIBRARY
The following relays have been added to the reference library...
GEC: CDG12, CDG13, CDG33, CDG14, CDG34, CDG16 & CDG36.
Reyrolle: TJV, TJEV, 2TJM10 & TJM10.
AEI: PBO2 & PBO2FAA.

Version 3.9.0 - Released 19/02/10
COPPER WIRE/TAPE ADDED TO CABLE SHEATH/SCREEN OPTION
Copper Wire and Copper Tape have been included in the Metallic Sheath/Screen drop down list under Cable, General
Information.
UPDATED ERACS RELAY REFERENCE LIBRARY DATA
Siemens ARGUS and SIPROTEC protection relays have been included in our reference library following the supply of
data from Siemens.
COPY LIBRARY KEY FACILITY
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The copy library keys facilities (individual and multiple) have been improved so that you are prevented from creating
duplicate entries.
ENHANCED DIAGRAM REFRESH
The single line diagram refresh time has been significantly reduced. On our test network (over 500 busbars) the refresh
time was reduced from 163ms to 47ms.
CUSTOMISED ARC FLASH HAZARD WARNING LABELS
A facility has been included in the Arc Flash Hazard module to allow users to generate customised Arc Flash Hazard
Warning Labels. Data fields can be added to a Warning Label template as required.
TUTORIAL MANUALS 1 & 2 UPDATED
The tutorial manuals 1 & 2 have been updated.
ERACS PROPERTIES CREATED
A number of keywords, known as "ERACS Properties" have been created. If these properties are included in text that
appears on the network diagram or protection graphs they will be replaced by a specific value. For example, one of the
properties is "[NetworkName]". The value for this property is the name of the currently open network. If you were to
add the following text, "Network Name: [NetworkName]" to a network called "Springfield Road Water Treatment
Works", when the text is drawn on the diagram it would appear as "Network Name: Springfield Road Water Treatment
Works".
LIBRARY KEY DESCRIPTION
The library key description field has been increased from 40 to 80 characters to accommodate more detailed
information.
UNIVERSAL DYNAMIC MODELLER - INPUT SIGNALS
The following input signal has been provided for DFIG, controlled shunt and wind turbine simulations: Sensed busbar
Frequency (pu).
WINDOWS REMOTE DESKTOP CONNECTION
ERACS has been modified so that it can operate over Windows remote desktop connection.
UPDATED ERACS CABLE REFERENCE LIBRARY DATA
Prysmian Protomont flexible trailing mining cables types 7,7M,7S,11,201,211,307,307M, 307S,321,331 & 631 have been
added to the Reference Library.
UPDATED ERACS FUSE REFERENCE LIBRARY DATA
Ferraz Shawmut type A033D1, A055D1 & A072D1 fuses have been included in the Reference Library.
CABLE WITHSTAND CALCULATIONS ADDED
Cable withstand calculations to BS standard have been implemented. This has enabled cable withstand curves to be
included on protection co-ordination plots and for the protection calculation to provide an indication of whether a cable
withstand has been exceeded.
UNIVERSAL DYNAMIC MODELLER - INPUT SIGNALS
The following input signals have been included for DFIG, controlled shunt and wind turbine simulations: Terminal
Frequency (pu), Terminal Voltage Magnitude (pu), Terminal Real Voltage (pu) and Terminal Reactive Voltage (pu).

ERACS Enhancements List

19

Version 3.8.0 - Released 18/02/09
PHASE IDENTIFICATION & COLOURS UPDATED IN LINE WITH EUROPEAN STANDARDS
The colours used to represent the phases have been aligned throughout Europe to be Brown, Black, Grey. ERACS has
been modified so that it uses the new colours, rather than the old Red, Yellow and Blue, and refers to the phases using
the L1, L2 & L3 naming convention instead of by colour.
WEB SECURITY KEY DIAGNOSTICS UPGRADED
Web security key diagnostics upgraded to included more informative messages when ERACS is unable to connect to the
web access server.
TEXT BUTTON ADDED TO TEXT TOOLBAR
A button has been included in the Text toolbar that enables text to be added to a diagram.
MOTOR MECHANICAL LOAD SYMBOL ADDED TO THE NETWORK DIAGRAM
When an induction machine has a mechanical load attached a symbol is included on the network diagram
IMPROVED CLASSICAL FAULT CALCULATIONS - WITH MOTOR CONTRIBUTION TURNED OFF
ERACS has the option to include or not include induction machine contribution in the classical fault calculation and
protection co-ordination programs. Both programs have been updated to improve the calculation when induction
machine contribution is turned off.
MEASURED VOLTAGE DISTORTION SYMBOL ADDED TO NETWORK DIAGRAM
When a busbar has measured voltage distortion (G5/4 data) associated with it a symbol is included on the network
diagram.
WIZARD ADDED FOR NEW NETWORKS
A wizard facility has been added to ease the creation of a new ERACS Network and explains the relationship between an
ERACS Network, Data State, Library and Database.
STUDY TYPE & TITLE ADDED TO WINDOW CAPTION
When a network diagram displays results the study type (Loadflow, Fault, IEC 909, etc.) and study title are shown in
the window caption to make it easier to identify the window contents, particularly when multiple windows are open.
AN APPEARANCE TAB ADDED TO ALL ELEMENT DATA FORMS
An appearance tab has been included in the data entry forms for all types of element. This tab includes controls that
enable you to specify some of the graphical properties for that element. For example, whether results should be
displayed on the single line diagram.
DEDICATED GRID INFEED RESULTS SELECTION ADDED
A 'Grid Infeed' branch has been included in the treeview of the results selection form for each of the following entries:
element data, loadflow, fault, harmonic injection, transient stability, protection co-ordination and G5/4. Previously
combined with the results selection for a synchronous machine.
1000 YARDS PER UNIT LENGTH OPTION ADDED
An item labelled '1000 yards' has been added to the list used to describe the per unit length of a cable.
UPDATED MODELS FOR MV & LV CIRCUIT BREAKERS & TRIPPING UNITS ADDED
Medium and low voltage circuit breaker models for various types of circuit breakers (air, SF6, Oil, MCCB & Vacuum)
have been updated including models of their tripping units and new graphical symbols. This includes updated data in
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the reference library.
ARC FLASH HAZARD MODULE RELEASED
An Arc Flash Hazard module has been added to ERACS. This module analyses arc flash hazards for electrical networks
modelled in ERACS and is based upon:
- IEEE Std 1584-2002: IEEE Guide for Performing Arc-Flash Hazard Calculations
- IEEE Std 1584a-2004: IEEE Guide for Performing Arc-Flash Hazard Calculations - Amendment 1 (which provides
additions and corrections to IEEE Std 1584-2002)
- NFPA 70E-2004: Standard for Electrical Safety In the Workplace
PRYSMIAN CABLE DATA ADDED TO ERA_REFERENCE_LIBRARY
Cable data including data sheets have been supplied by Prysmian for use by the ERACS Team and have been added to
the ERACS Reference Library (including updated zero sequence impedance information)

Version 3.7.2 - Released 02/01/08
SERIES ELEMENT LABELS
The series element resistance and reactance labels have been changed from +/-/Zero Sequence to Pos, Neg and Zero
Sequence.
NEW ACCESS TO ACQUIRE LIBRARY DATA WIZARD
A copy facility has been included in the library key management form. When this option is selected the acquire library
data wizard introduced at ERACS 3.7.1 is started and enables a library key to be easily copied to the active library.
PROTECTION I SQUARED T CHARACTERISTIC ADDED
ERACS has been updated to enable an I squared t characteristic to be added to a multi-stage protection device.
FUSE LIBRARY UPDATED
Fuses from the following manufacturers have been added to the ERACS Reference Library: Eaton, GEC Alsthom, Merlin
Gerin, SandC and Schneider.
COPY LIBRARY KEYS WIZARD ADDED
The 'Copy Keys' facility has been made much easier. The process is now implemented in the form of a wizard, thereby
making it much easier and simpler to copy multiple library keys between libraries.

Version 3.7.1 - Released 05/11/07
GRAPHICAL TRACE FACILITY
A trace facility has been added to the Transient Stability, Harmonic Impedance and Protection graphs. This facility
enables users to read off more accurate values from the curves.
WEB ACCESS TOOLBAR
A web access toolbar has been added to the ERACS control panel. This toolbar provides quick access to the following
features provided by the ERACS User Site: FAQs, Downloads, ERACS Power Engineering Forum and Online Demos.
PROTECTION SETTINGS
The maximum number of multi-range setting ranges for both current and time settings has been increased from 5 to
10.
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ELEMENT DATA DISPLAY AUTOMATICALLY UPDATED
After clicking 'Show Data' to display data on the diagram, when an element's data is modified, the diagrammatic data
being displayed is now automatically updated.
CABLE DATA FORM UPDATED
Fields have been added to the cable library data entry form to enable users to record greater information and in
preparation for the implementation of cable withstand calculations. Fields Include: Cross sectional area, Cross sectional
area units,. Conductor material, Number of cores, Armour, Unit Length, Insulation and Manufacturer.
PROTECTION CO-ORDINATION MCB MODEL
A new miniature circuit breakers (mcb) model has been added for use in Protection Co-ordination including a dedicated
single line diagram symbol.
PROTECTION DISCRIMINATION DISPLAY
The following two options have been provided in the discrimination box's popup menu: Send To Back and Bring To
Front.
WEB ACCESS SECURITY ADDED
A new security solution called 'Web Access' has been added to ERACS. This solution does not use a hardware security
key (dongle). Instead, we will host your ERACS licence on our Web Server and provided that you have an active internet
connection, you should be able to connect to our server from anywhere in the world.
MEASURED VOLTAGE DISTORTION
Three buttons have been added to the library form that enable users to clear, export and load voltage waveforms...
- 'Clear' - This will clear the characteristic.
- 'Export' - This will export the characteristic to a comma separated variable (csv) file.
- 'Load' - This will load the characteristic from a csv file.
LIBRARY DATA WIZARD ADDED
A wizard facility has been added to ease the acquisition of library key data when no library keys, of the element type
selected from the network diagram, are present in the project libraries. The wizard steps through the process of either...
- creating a new library key
- copying a library key from a library of the user's choice
- copying a library key from the ERACS Reference Library
...then associates the newly created/copied library key with the selected network diagram element. Please see
associated movie for additional information and further instructions.
ERA_REFERENCE CABLE LIBRARY RATINGS UPDATED
Where possible cable entries in the reference library have been updated in line with RINA Consulting Cable Rating
Reports (Ref. 69-30).
ERA_REFERENCE CABLE LIBRARY IMPEDANCES UPDATED
Where possible cable zero sequence impedance values (R0, X0 and C0) have been set to 3 times the positive sequence
values for multicore cables and 1.25 times for single core cables (Ref. J&amp;P Switchgear Book 7th Edition).
ERA_REFERENCE FUSE LIBRARY UPDATED
The number of fuses provided in the library has been substantially increased. Fuses produced by manufacturers such
as: ABB (5 product ranges), AREVA (6 product ranges), Cooper Bussmann (59 product ranges), Ferraz Shawmut (4
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product ranges), GE Power Controls (14 product ranges), SIBA (22 product ranges) and Siemens (25 product ranges)
are now available.
ERA_REFERENCE MCB LIBRARY UPDATED
Miniature circuit breakers produced by manufacturers ABB (5 product ranges), MEM (3 product ranges) Merlin Gerin (11
product ranges), Moeller (7 product ranges), Siemens (15 product ranges) and Terasaki (10 product ranges) are now
available.
ERA_REFERENCE CABLES LIBRARY UPDATED
Additional cables have been added and the reference library now includes the following cables: 300 x 1kV, 240 x 3.3kV,
70 x 6.6kV, 200 x 11kV, 56 x 22kV, 120 x 33kV, 3 x 66kV, 7 x 132kV, 7 x 275 kV and 4 x 400kV.
ERA_REFERENCE TRANSFORMER LIBRARY UPDATED
100 two-winding distribution transformers have been added to the reference library, increasing the total to over 150.

Version 3.7.0 - Released 01/06/07
NEW PROTECTION TOOLBAR
A "protection" toolbar has been added to the ERACS main application window and provides quick access to the main
protection functions (New Setting Graph, Open Existing Setting Graph, Edit Device Settings, Stability Checking, Dynamic
Studies & Protection Analyser)
PROTECTION DEVICE DISCRIMINATION MARGIN
The ability to display the discrimination margin between two protection devices has been included on the protection
graphs. Multiple selections may be displayed on the same graph using either common fault currents per pair of curves
or individual fault currents. This feature illustrates the margin using a shaded region of a user defined colour. A second
region, using the same colour is drawn and includes the current and operating time of each device, together with the
discrimination time between the two devices.
PROTECTION CURVES FORM UPDATED
1. Intelligent curve hints
2. Enhanced and clearer colour coded curves and labels
3. Individual curves can be temporarily hidden
EDIT PROTECTION SETTINGS
A new facility has been provided that enables you to more easily edit the settings of a protection device.
PROTECTION DEVICE SELECTION
When a protection device is selected for inclusion in a protection graph the device is shown flashing and now a tick is
drawn over the top of the protection device symbol.
CURVE PRINTING
It is now possible in protection co-ordination, harmonic impedance and transient stability to print curves in black and
white using "grayscale" as well as the original "dots and dashes" style.
PROTECTION SETTING GRAPHS
The method used to sort the protection devices that have been selected for inclusion in a protection graph has been
updated. Devices may be now added, removed and sorted

ERACS Enhancements List

23

GROUP SWITCHING FACILITY
A "Toggle" option has been added to the group switching facility. The group switching facility is now also available for
ERACS users provided with the "Operator" access mode.
ERACS MANUALS
ERACS User & Technical manuals may now be opened from within ERACS using Adobe Acrobat as well as previously
Acrobat Reader.
CABLE RATING DESCRIPTORS
ERACS cable entry and library data entry forms have been modified to use the terms: "Rating in Air", "Rating in Ground"
& "Rating in Duct". As the RINA Consulting Cable Reports (69-30) show that the highest rating is not always in air and is
dependent on the cable's CSA, the descriptions have been changed from "Highest Rating in Air", "Normal Rating
Underground" & "Lowest Rating in Duct".
SNAP TO GRID
It is now possible to individually control which items will be snapped-to-grid. Four options are available: "Snap elements
to grid", "Snap text to grid", "Snap identifiers to grid", and "Snap results to grid".
SAVE STUDY RESULTS
Default option added to "save" or "not save" study results.
GE LM6000PA GAS TURBINES
The maximum number of LM6000Pa gas turbines has been increased from 5 to 10.
DELETE DATABASE FORM
Additional text has been included on the delete database form to inform users that only empty databases can be
deleted.
DATA STATES
The checks ERACS makes to decide whether a new data state and new network are required have been updated.

Version 3.6.1 - Released 15/12/06
NEW ERACS USER WEBSITE
The ERACS User website has been revamped and updated and now includes many more FAQs and other useful
resources.
ERACS POWER ENGINEERING FORUMS LAUNCHED
The purpose of the forums is to create a meeting place where discussion and exchange of information relating to
Electrical Power Systems can be cultivated amongst ERACS Users. Forums available are: General, Modelling, Power
Quality, Protection, Earthing and Renewables.
FIND FAULTED ELEMENT ADDED
Find Faulted Element has been added to the "Find" option of the "Edit" menu. This item is enabled when results for
Fault, IEC909 and Protection studies are displayed on the network diagram and the diagram contains a single faulted
element. When selected diagram focus is moved to reveal the element that has the fault applied to it.
NUMBER OF SERIES ELEMENTS INCREASED
10-bus system increased from a maximum of 5 to a maximum of 10 series elements
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50-bus system increased from a maximum of 10 to a maximum of 25 series elements
100-bus system increased from a maximum of 20 to a maximum of 50 series elements
150-bus system increased from a maximum of 30 to a maximum of 75 series elements
300-bus system increased from a maximum of 60 to a maximum of 150 series elements
500-bus system increased from a maximum of 100 to a maximum of 250 series elements
1500-bus system remained at a maximum of 400 series elements
DEFAULT RESULTS BUTTON ADDED
A "Defaults" button has been added to the "Select Data/Results" form. When clicked this button will return the Element
and study combination to their default result selection.
REFERENCE GENERATOR SELECTION UPDATED
The text and caption of the "Reference Generator" group box of the Transient setup panel has been improved. It now
reflects the fact that a grid infeed or synchronous machine can be selected.
STUDY SETUP/RESULTS SAVE OPTION
An option has been provided that enables you to select whether study results should be saved to the main database.
When this option is selected the study set-up information is saved to the master database so that the study can be
easily run again at a later date. However, the results produced by the study are not saved, which means that the size of
your database files will be significantly reduced.
TOOLBAR ADDED TO DATA ENTRY FORMS
A toolbar has been added to each element's data entry and to the library data entry forms. The toolbar includes the
following buttons:
Help: Opens the Help file at the appropriate entry.
Print: Starts the print facility for the appropriate entry.
Manual: Opens an ERACS manual.
Current Base Converter: Starts the current base converter.
Impedance Base Converter: Starts the impedance base converter.
Impedance Converter: Starts the per-unit to ohms (or vice-versa) impedance converter.
General Units Converter: Starts the general unit converter.
DYNAMIC MANUAL LINKING
Selecting the manual icon from the new toolbar automatically links to the appropriate page of the User/Technical
manual.
DELETE STUDY RESULTS OPTION ADDED
When a study is deleted an option has been provided that enables you to delete the study results, but leave the study
setup information in place. This means that you can reduce the size of your databases (provided that a Database Health
Check is performed after the deletion) and that studies can be re-run.
SUPERPRO PARALLEL SECURITY KEY
ERACS now supports the new slimmer SuperPro parallel security key.

Version 3.6.0 - Released 26/05/06
USB SECURITY KEY OPTION
Facilities have been added to enable ERACS to operate with a USB security key as an alternative to the parallel security
key option currently offered.
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PROTECTION ANALYSER
The purpose of this facility, known as the "Protection Analyser", is to enable you to quickly analyse the performance of
the networks entire protection scheme. Faults may be applied to every element in the network and are performed in a
batch, one after another. For each study, information, which includes "clearing time", "minimum discrimination time",
"number of isolated busbars" and an indicator on whether the fault was cleared, is recorded. After all studies have been
performed, the recorded information is presented in a tabular format. Facilities are provided that enable you to highlight
those studies that, for example, did not clear the fault or had an excessive clearance time, and, to also perform a
detailed protection study of any of the studies performed during the survey.
TRANSIENT RESULTS
Transient Stability now calculates the following values for lines, cables and series elements: volt drop (pu), volt drop
(kV) and power loss (MW). Each of these values may be displayed on your single line diagram.
RESULTS FOR AVR & GOVERNOR SIMULATIONS
Following a Transient study, AVR / governor simulations can now be viewed and each of the simulation blocks is
annotated with its output value.
VOLTAGE LEVEL KEY AND VOLTAGE LEVELS & COLOURS
A key describing the voltage levels employed by your network can now be drawn on your single-line diagram. Voltage
levels and corresponding colours have now been made a property of the network rather than user's personal setting.
When networks are supplied to colleagues or client companies the selected voltage settings stay fixed rather than
adopting the users local settings.
SAVING NETWORK DIAGRAMS
The facility that enables a network diagram to be saved as a bitmap has been improved and now enables the diagram
to be saved in the following formats:
- JPEG format (jpg)
- Windows metafile (wmf),
- Enhanced metafile format (emf)
- Bitmap (bmp)
ELEMENT IDENTIFIER
When an element is added to a network is now provided with a default name. The name is optional and may be
modified if required.
BUSBAR FAULT RATINGS
After a busbar has been edited, and if either of the fault ratings have changed, a facility has been provided that enables
the ratings to be applied to switchgear attached to the edited busbar and to those busbars that are connected to the
edited busbar via bus-sections.
BUSBAR FAULT RATINGS
The default three phase and single phase fault ratings are now set the same value according to voltage level as
described below...
- less than or equal to 0.415 kV = 31 MVA
- less than or equal to 3.3 kV = 36 MVA
- less than or equal to 6.6 kV = 72 MVA
- less than or equal to 11 kV = 250 MVA
- less than or equal to 33 kV = 1000 MVA
- less than or equal to 66 kV = 2400 MVA
- less than or equal to 132 kV = 4500 MVA
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- less than or equal to 275 kV = 15000 MVA
- greater than 275 kV = 35000 MVA

Version 3.5.1 - Released 12/12/05
RELAY CURVES
The number of curves that can be associated with a stage of a multi-stage relay has been increased from 10 to 20.
PROTECTION GRAPHS
An option has been added to pre-study and post-study protection graphs that enable a title to be included below the
x-axis.
UPDATE INFORMATION
An ERACS update information service has been added to ERACS. The first time ERACS is started after an ERACS update
has been applied a form will be displayed providing you with facilities that enable the release notes and update movie to
be viewed.
NEW ERACS USER FORUMS
A menu item called "ERACS User Forums" has been included in the Help menu. Selecting this item will start your default
web browser and open the ERACS User Forums.
WIND TURBINE HARMONICS
It is now possible to select wind turbine generators as sources of harmonic currents.
HARMONIC TIME DOMAIN WAVEFORMS
A facility has been added to the Harmonic Injection module that enables you to select elements for which time domain
waveforms will be displayed.
LICENCE AGREEMENT
A facility has been added to the Help | About ERACS form that enables the end-user licence agreement to be displayed
and printed.
NEW ERACS DOCUMENTATION FACILITY
An option has been added to ERACS that enables one or more documents to be selected and attached to any element in
a network or network. The documents are presented in a list and controls are provided to manage this list. Provided
that the document has been associated with a Windows application then it is possible to open the document from within
ERACS.
PROTECTION STABILITY OPTION
This tool compare the setting of each protection device against the loading current calculated by Loadflow. All devices
that have failed the stability check will be shown flashing on the network diagram and a control panel is displayed listing
the devices. Facilities are provided that enable you to adjust the settings of a device.
IMPROVED DATA STATE CONTROL
After a library key has been edited ERACS asks whether elements that use the key should be updated. Prior to this
release, regardless of whether the library key affects Loadflow results, if the data state had results or child data states,
one was required to create a new data state. This behaviour has been modified such that ERACS does not require a new
data state if the library key does not affect Loadflow results.
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NEW GRAPH OPTION FORM
A tab labelled "Graph" has been included in the Options form, available from the Tools menu. This tab provides controls
that enable you to select the colours used for the lines displayed on the various graphs/charts.

Version 3.5.0 - Released 15/06/05
MANUALS
Technical Manual and User Guide have been updated.
HARMONICS G5/4
A new program option called 'G5/4' has been added to the ERACS suite.
Engineering Recommendation (ER) G5/4 sets the planning levels for harmonic voltage distortion to be used in the
process for the connection of non-linear equipment to the public electricity system within the United Kingdom.
The G5/4 calculation implemented in ERACS will calculate voltage distortion and harmonic currents flowing at the point
of common coupling (PCC) as a result of the connection of non-linear loads. These voltage distortion and harmonic
currents are subsequently compared against the planning levels specified in ER G5/4 and are presented in a tabular
format.
HARMONIC PROFILE
An option has been added to display output from the harmonic injection and G5/4 programs in the following forms:
periodic waveforms, phasor diagrams, magnitude spectrums and phase spectrums.
BUSBAR VOLTAGE WAVEFORMS
As a result of the new G5/4 option a new library element has been added called 'Measured Voltage Distortion'. Data is
entered in a tabular form and may be viewed as a waveform. The waveforms are then selected and viewed via the
Busbar data entry form. Although primarily intended for use with the G5/4 option this facility lends itself to being a
depository for power quality and harmonic survey data.
GE WIND TURBINE MODEL
DFIG model for the GE wind turbine now available.
GOVERNOR RATING
ERACS now allows the power rating of a generator's governor/prime mover to be specified. Previous to this
enhancement, ERACS assumed that the governor rating was the same as the generator's MW rating.
HARMONIC DISTORTION
Harmonic distortion is now calculated for polluting sources.
PROTECTION DEVICE STATUS
In order to make the identification of protection devices whose status has been set to off much clearer, a feature has
been included that allows the identifier of such devices to be shown in grey. A control has been added to the
Tools|Options|Appearance dialog that enables this feature to be disabled.
CORE TYPE TRANSFORMERS
A model for core-type 2 winding transformers that are connected star to grounded-star (or vice versa) has been
included. This model enables the zero sequence representation of this type of transformer connection to be represented
more accurately.
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TRANSPARENT TEXT
Facilities have now been included that enable you to toggle whether diagram text is transparent. This property is
applied to text on-screen and when printed out.
ROTATE TEXT
Added on-screen text may now be rotated.
DATABASE CHECK
When a new network is created, or when a network is imported, a check is made to determine whether the network will
be placed in the ERACS example networks database (ERACSNetworks). If the check is positive then a warning message
is presented. The check has been included as this database may be updated by the ERACS Team at a future update and
will be deleted when ERACS is uninstalled.
E-MAIL DATABASE
A selection labeled "Send Zip Archive to ERA" has been added to the form displayed when a database or library is
zipped. If the selection is made the zipped database or library will be attached to an e-mail, addressed to ERA.

Version 3.4.2 - Released 10/01/05
WIND TURBINE GENERATORS
A facility to model doubly fed induction generators (DFIG's) has been added to ERACS.
NON OPERATING RELAYS IN PROTECTION CO-ORDINATION
It is now possible to select non-operating relays for inclusion in the co-ordination plots produced following a protection
study.
USER SELECTABLE REFERENCE CURRENT IN PROTECTION CO-ORDINATION
When a protection co-ordination plot is produced following a protection study it is now possible to select the reference
current (that used to set device offset). In previous versions of ERACS it was fixed at the current sensed by the
protection device that was selected first. Facilities have been introduced that enable you to select which device is to be
the reference. A feature has also been included that enables one of the phase currents flowing into the fault to be
selected as the reference.
INCREASED 150BUS SYSTEM ELEMENTS
The maximum number of the following types of element, supported by the 150-Bus version of ERACS has been
increased...
- Lines: from 125 to 150.
- Cables: from 125 to 150.
- Circuit breakers: from 1225 to 1500.
- Induction machines: from 120 to 150.
- Shunts: from 225 to 300.
- Bus sections: from 100 to 150.
- Series elements: from 25 to 30.
TRANSFORMER DERATING FACTORS
The harmonic injection module now calculates the following transformer derating factors:
- K-Factor; the Underwriters Laboratories Inc.
- Harmonic Loss Factor; ANSI/IEEE C57.110-1998.
- Factor K; BS 7844-3:1998 or BS 7821-4:1995.
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ADDITIONAL BUSBAR VERSIONS
Four additional sizes are now available for ERACS - 50Bus, 100Bus, 300Bus and 500Bus.
ERACS EXPORT INTERFACE
Loadflow Parameter fields are now included in the ERACS export interface.
ADJUSTABLE BUSBAR THICKNESS
It is now possible to adjust the thickness of a busbar. To achieve this, place the mouse cursor over the busbar and click
the mouse right-button. Select "Adjust Thickness" in the popup menu. The adjustment control will appear. To cancel the
adjustment press the &lt;ESC&gt; key. To complete the adjustment click the mouse left button outside the adjustment
control.
CABLE & LINE PROPERTIES
The field called "Length" has been included in the information list displayed when the element's properties have been
selected.

Version 3.4.1 - Released 15/10/04
ERACS EXPORT/IMPORT INTERFACE UPGRADE
Data and result locations have been added to the interface as well as bus section and circuit breaker switch groups.
NEW USER ACCESS LEVEL
A new access level called "Student" has been created. This level provides all the same rights as "User" access level,
except that students are prevented from changing their own password and username.
SUPERVISOR PASSWORD
ERACS has been modified to enable the Supervisor's (the user with username "Supervisor") Password, Full Name,
Phone, Fax and E-mail fields to be edited. The Username and Access Level can not be edited. To access this facility you
must be logged into ERACS as the Supervisor.
RELAY POLARISATION VOLTAGE
The minimum polarisation voltage for all protection relays is now 0.0001% and the default value is now set to the
minimum allowed rather than 1%.
TECHNICAL MANUAL UPDATE
A section on controlled shunts has been added to the manual. A note has also been included in the element data section
of the technical manual to remind users that when adding a capacitor to the library using the fixed impedance model
the reactance should be set negative. If the fixed admittance model is employed then the susceptance should be set
positive.
TRANSIENT SETUP
Transient setup has been modified so that when a switch event is made the next logical switching action is pre-selected.
For example, if the last event applied to the switch is "open", "close" will be pre-selected and vice versa.
DEFAULT RESULTS ADDED
When a network is created a default set of results is automatically associated with it for each of the calculations.
USER EDITABLE REFERENCE VOLTAGE
Pre-study protection curves. Should the selected protection devices be at different voltage levels facilities have now
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been provided to enable you to edit the reference voltage. To change the reference voltage select the option called
"Reference Voltage..." from the Edit menu. This option is also provided from the sub-menu presented when "Edit" is
selected in the graph's right button pop-up menu.
PROTECTION DEVICES CAN NOW BE ADDED TO BUS SECTIONS
Protection devices can now be attached to Bus Sections.
DIRECTIONAL RELAY INDICATOR ADDED TO GUI
Two facilities have been included that enable directional protection relays to be identified on the network diagram:
1) If one or more of the relays at a given location are directional then a letter "D" is written in the centre of the relay
symbol.
2) If a relay is directional and its identifier is displayed, an appropriately directioned arrow will prefix the label.
By default these features are enabled. However, both may be disabled/enabled by checking items in the Protection
option of the View menu.
HARMONIC IMPEDANCE GRAPHS
The maximum number of points for harmonic impedance graphs has been increased from 400 to 4000.
REFERENCE LIBRARY UPDATED
Additional example data has been added the ERA_Reference_Library (Static VAr compensators, shunts, harmonics
sources, time variant functions, mechanical loads etc).

Version 3.4.0 - Released 09/06/04
USER SPECIFIED VOLTAGE RANGES
For colour coding the network diagram the user can now specify voltage range and colour. (Tools | Options | Voltage
Levels).
EXTRA WARNING IN DELETE MODE
When the Network Explorer is displayed in "Delete" mode a delete symbol has been included on the Delete button, the
form's caption now indicates that it is open in delete mode and the help text is shown in red.
LIBRARY KEY UPDATE FORM
The form used to display missing / out-of-date library keys is now resizeable and if the key refers to an embedded
element the list includes a description of the element that it is embedded in.
NEW USER ACCESS LEVEL
A new class of user access level has been implemented. Known as "User", this level allows users to: Create networks,
libraries and databases; edit network and library data, delete network and library data, print data; change connectivity;
and run calculations. The "User" access level prevents users from, Creating user accounts; manipulating other user
accounts; and, changing system settings.
ENHANCED PASSWORD MANAGEMENT
The ERACS User and Password management form has been updated so that it now lists all ERACS users, making it
much easier to manage user accounts.
ADDITIONAL TIF WEIGHTING FACTORS
A control called 'TIF Weighting Factors' has been added to the Harmonic Injection setup panel. This enables you to
select which table of values the injection program will employ to calculate TIF weighting factors. Three options are
provided...
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1) '1935 Values' - the Injection module will employ the 1935 weighting factors (to date ERACS has only used these
values) defined on page 757 of the "Electrical Transmission and Distribution Reference Book" by Westinghouse.
2) 'IEEE 519-1992' - the Injection module will employ the values from table 6.2 in the IEEE standard 519-1992.
3) 'CCITT Vol.VI' - the injection module will employ the values from the table associated with Figure 1/4 in the ITU
CCITT Directive Volume VI "Danger And Disturbance".
MULTIPLE COPY PRINTING
A control has been added to the print setup form to enable multiple copies of a network diagram or graphs to be
printed.
UPGRADED POST PROTECTION CONTROLS
A post-protection control panel has been created that combines the controls previously used to navigate protection
stages and highlight protection devices. This panel is automatically displayed following a protection study.
IMPROVED TRANSIENT STABILITY SETUP
After clicking the Add-Event button or the Add-Plot button, ERACS now remains in a "selection" mode until you select
"Finish" from the right-button shortcut menu or if you press the "Esc" key.
ADDITIONAL TRANSIENT PLOTS
It is now possible to select any of the results produced for shunts as a Transient plot parameter. Facilities have also
been provided that enable the output of any block from a UDM simulation to be selected as a Transient plot parameter.
As AVR's, governors and controlled shunts are modelled using UDM simulations, this feature enables any of their block
outputs to be plotted during a Transient study.
ERACS MAIN PANEL
The main ERACS panel is now resizeable and remembers its location, size and state between sessions.

Version 3.3.1 - Released 19/12/03
SHUNT CONNECTED CONTROLLERS
ERACS now has the capability of modeling shunt connected devices that can control busbar voltage, branch P, Q and
power factor in Loadflow and Transient Stability such as static VAr compensators, fuel cells, energy storage devices,
power factor controllers and saturable reactors. A sophisticate model for an ELSPEC reactive power compensation
system has already been developed.
SECURITY KEY UPDATE WIZARD
A facility has been included that enables the ERACS Team to update your ERACS license without the need to exchange
dongles. The update procedure consists of the ERACS Team providing you with a security update file via e-mail. You
save this file on your computer and start the "ERACS Remote Security Key Update Wizard" by selecting "Update Security
Key" from the Tools menu. This wizard will then guide you through the update procedure.
INDUCTION MACHINE DATA CALCULATOR
A new tool that can be used to calculate ERACS data requirements for an induction machine has been included. This
tool is activated by selecting "Induction Machine Data" from the "Calculators" option of the "Tools" menu. Given four
pieces of information that can be easily determined from manufacturers data sheets the calculator will determine the
induction machine's data values to be entered in ERACS. The tool produces the torque vs speed, current vs speed and
power-factor vs speed characteristics, which can be compared against those of the manufacturer. Once happy with the
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data a facility is provided to write the data to an ERACS library.
EXCEL REPORTS
Four Excel reports have been created to display various Loadflow results - "Fault Level Profile", "Power Flow",
"Transformer Tap Setting" and "Voltage Profile". These are located in the ERACS Template folder and are activated
from within ERACS by selecting "Loadflow Excel Reports" from the Results menu.
PROTECTION DEVICE DATA
When protection device data is printed from the properties form after a protection calculation has been performed the
graph title includes both device identifier and the device description.
BUSBAR ORIENTATION
It is now possible to orientate a busbar both vertically and horizontally before it is placed on the network diagram by
pressing the letter "R".
DIAGRAM NAVIGATION OPTIONS
It is now possible to navigate the diagram workspace using the mouse wheel and keys...
- To move up use the mouse wheel, up-arrow key or PgUp key.
- To move down use the mouse wheel, down-arrow key or PgDn key.
- To move left use the left-arrow key.
- To move right use the right-arrow key.
- To move to the bottom right hand corner of the diagram, press the End key whilst holding the Ctrl. key down.
- To move to the top left hand corner of the diagram, press the Home key whilst holding the control key down.
- To move to the top of the diagram, press the up-arrow key whilst holding the Ctrl key down.
- To move to the bottom of the diagram, press the down-arrow key whilst holding the Ctrl key down.
- To move to the right hand edge of the diagram, press the right-arrow key whilst holding the Ctrl key down.
- To move to the left hand edge of the diagram, press the left-arrow key whilst holding the Ctrl key down.
DIAGRAM ZOOM OPTION
Use the mouse wheel to zoom into and out of the network diagram.
- To zoom-in, press the Ctrl key and scroll the mouse wheel up.
- To zoom-out, Press the Ctrl key and scroll the mouse wheel down.

Version 3.3.0 - Released 24/07/03
MULTI-STAGE RELAYS
ERACS now supports relays that have one or more stage of operation. The model implemented by ERACS allows up to 5
stages to be defined, with up to 10 curves being associated with each stage.
UNIVERSAL DYNAMIC MODELLER
The Universal Dynamic Modeller has been converted from a DOS application and is now a Win32 application. With
enhanced modeling capabilities.
SYSTEM INFORMATION
A facility that obtains information about your ERACS installation has been included. The information retrieved includes;
module version numbers, ERACS installation directories, operating system information, disk space and RAM. To obtain
system information select About from the Help menu and click the button labeled "System Info..." on the About form.
LOADFLOW SUMMARY RESULTS
The following two values have been included in the Loadflow summary results selection...
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- Number of iterations taken to solve Loadflow
- Loadflow convergence error
NETWORK IMPORTER
To compliment the export feature an additional method of importing network data has been provided, using our
common data interface. The format adopted by the interface is to use a structured, ASCII formatted text file. A pdf file
describing this interface is provided and can be accessed by selecting 'Network Import' from the Help|Specifications
menu.
ERACSPAD
A general purpose editor that supports both text and RTF formatted files has been included. To start ERACSPad select
"ERACS Pad..." from the Tools menu.
DATABASE NAME
The total number of characters that comprises an ERACS database name, including the directory name, has been
increased from 75 to 240. Please note however, that the maximum number of characters that can be used for the
database name alone remains unchanged at 40 characters.
NEUTRAL EARTHS
The maximum number of neutral earths has been increased as follows...
10-bus system increased from a maximum of 10 to a maximum of 25 neutral earths
150-bus system increased from a maximum of 75 to a maximum of 180 neutral earths
1500-bus system increased from a maximum of 500 to a maximum of 1200 neutral earths
PROTECTION RELAYS
After a protection relay has been added to a network ERACS will ask whether you wish to add links to circuit breakers.
LOADFLOW
Loadflow now calculates "Percentage kA Loading" for transformer windings. The result is displayed on-screen and in the
CSV results.
ELEMENT RESULTS
A new option, "Element Results", has been included in the View menu. This option enables one to globally hide/unhide
element results.
LOADFLOW
Loadflow result, "Percentage Loading", has been changed to be more descriptive and reads "Percentage kA Loading" for
lines and cables. For all other elements it is now "Percentage MVA Loading".
LOADFLOW
"Percentage MW Loading" is now calculated by Loadflow for induction and synchronous machines. The result is
displayed on-screen and in the CSV results.
PROTECTION CO-ORDINATION
Protection Co-ordination Graphs. It is now possible to add and remove devices from previously saved co-ordination
graphs.

Version 3.2.2 - Released 27/11/02
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BUS SECTIONS AND CIRCUIT BREAKER RATED VOLTAGE
When adding a bus section or circuit breaker the element's rated kV defaults to the nominal voltage of the busbar it is
connected to.
INDUCTION MACHINE SPEED PROFILES
A tab has been included in the induction machine data entry forms (both network and library) that displays one of the
following speed profiles - Current/Speed, Torque/Speed and Power factor/Speed. Rescale graph, Export graph data to
CSV file and hard copy print is also included.
ELEMENT RESULTS
Result units (e.g. MVA) have been added and can be displayed on screen and in printed diagrams. You can select
whether to display the original result identifiers on screen and in printed diagrams. The background of PRINTED results
can be made transparent or solid white.
BUSBAR FAULT RESULTS
Busbar results for the Fault calculation have now been divided in two groups - "Single Fault" and "Fault Survey". Instead
of having a single results selection for both fault options, separate results selections have been provided for each.
OPEN CIRCUIT FAULTS
Both single-phase and two-phase open circuits faults can now be represented by our Fault module. These types of fault
may be applied to lines, cables, transformer windings, series elements, shunts, induction machines and synchronous
machines.
LOCATING SUMMARY RESULTS
An option called "Find Summary Results" has been added to the Edit menu. This option is only enabled when the single
line diagram is shown and displays summary results. When this option is selected focus is automatically moved to the
area on the diagram that includes the summary results box.
MULTI-POINT MECHANICAL LOAD
The speed torque characteristic for mechanical loads represented by a multi-point curve are now drawn when printing
induction machine data.
LIBRARY & NETWORK DATABASE MANAGEMENT
Facilities have been included to enable network and library databases to be Copied, Moved, Renamed and Zipped. For
network databases these features have been included in the Database menu. For library databases they have been
included in the Library menu.

Version 3.2.1 - Released 30/07/02
IMPORTING LIBRARY DATA
An additional method of importing library data has been provided, using our common data interface. The format
adopted by the interface is using a structured, ASCII formatted text file. A pdf file describing this interface is provided
and can be accessed by selecting 'Library Import' from the Help|Specifications menu.
TOOLBAR BUTTONS
A number of new toolbar buttons have been added to speed access to regularly used features. These include: Open
Results in Spreadsheet View, Open Data in Spreadsheet View, View Data / Results Listing, Save Network As, User
Options and View Element Hotspots.
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PROTECTION GRAPH TEXT
It is now possible to move text that has been added to a co-ordination plot.
PROTECTION GRAPH RECORDS
Facilities have been added to Rename and Delete previously saved protection grading curve records.
TRANSIENT EVENTS LISTING
When printing Transient plots an option has been included to disable the study events listing.
LOADFLOW CONVERGENCE METHOD
The Loadflow Convergence Method is now written to the 'Study Parameters' section of the Loadflow listing file.
MECHANICAL LOAD
It is now possible to deselect an induction machine's mechanical load. A button labeled 'Deselect' has been included on
the induction machine's mechanical load page.

Version 3.2.0 - Released 15/03/02
RELEASE NOTES
An option called 'Release Notes' has been added to the Help menu. When this option is selected a list of all release
notes is presented. Selecting one of the items will automatically load it into the application that has been associated
with files having the extension '.TXT'.
LINE SEGMENTS
It is now possible to insert segments into lines, cables and transformer windings. To insert a segment, select 'Insert
Segment' from the element's right button popup menu. A point will be introduced midway between the selected point
and the next one along. If you happen to select the last point then a point is introduced midway between the selected
point and the previous one.
STARTING MOTORS
It is now possible to start motors that include embedded cable.
LIBRARY LISTING
As a result of upgrading to the latest release of Delphi (Tool used to create the GUI) we are now able to include graphs
in library listing for protection devices, harmonic sources and time variant functions.
ELEMENT HOTSPOTS
An option has been included in the 'General' tab of the Options form that enables the element hot spots to be displayed.
To show element hot spots, select Options from the Tools menu. Open the General tab and tick the box labelled 'Show
Element Hotspots'.
NETWORK & DATA STATE NAMES
You can now rename/edit a network's name and a data state's name.
BUSBAR ID'S
The identifiers of the busbars to which elements are connected has been included in the Loadflow results exported in
CSV file format.
BUSBAR RESIZE
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In order to make the diagram building more intuitive busbars may now be resized from either end and moved using any
location between the ends. Note that the mouse icon changes to a double ended arrow when placed over a resize
hotspot.
ENHANCED PASTE FACILITY
When a group of elements are copied and subsequently pasted into a network the paste frame is drawn the same as
the original selection. Thereby, enabling you to place elements more accurately.
BORDER/LEGEND OPTION
Controls have been included on the network and graph printing forms that enable you to include/exclude the border and
legend from the printed output. Please note that you can have a border without a legend, but you cannot have a legend
without a border.

Version 3.1.3 - Released 29/10/01
SETTING PROTECTION DEVICES
To make the adjustment of devices that have many current/time settings much faster, controls have been provided that
enables you to specify the setting directly.
IMPEDANCE BASE CONVERTER
This conversion utility is available from the Calculations option of the Tools menu and enables you to convert a per unit
impedance from one set of base values to another.

Version 3.1.2 - Released 25/07/01
DATABASE PROPERTIES
A Properties option has been included in the Database menu. When selected a form is displayed listing the name,
location, size and contents of the database currently being used.
DATABASE HEALTH CHECK
A facility has been included to enable you to check and correct your libraries and network databases for errors. In some
instances this facility can also reduce the size of your network databases. To perform a health check on a network
database select 'Health Check' from the Database menu. To perform a health check on a library database select 'Health
Check' from the Library menu.
SCALE DIAGRAM
It is now possible to scale your network diagram. This facility is available via the 'Scale Diagram...' option of the Edit
menu. When selected you will be requested to enter X and Y scaling factors (%). These figures will be used to scale the
X and Y co-ordinates of every element. Please note that this facility does not increase or reduce the size of the element
symbols.
LIBRARY RESELECTION
A facility has been included which enables you to reselect a network's library. This facility is automatically started when
a network is loaded and ERACS is unable to locate the library it is using. If the library is not found ERACS will enable
you to select another library, which it will then check for the presence of the appropriate library keys.
LOADFLOW RESULTS
Power loss (PLO), kV volts drop (dV) and per unit volt drop (dpV) are now calculated for lines, cables and series
elements.
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UNZIP ARCHIVE
A facility to unzip archives has been included in the file menu. In addition to unzipping archives produced by ERACS this
facility will also unzip regular zip files.
OPENING RESULTS FILES
A new feature called 'Open Data / Results Listing' has been included in the Results menu. This feature provides access
to a maximum of three options dependent upon the type of study results being displayed on the network diagram. For
example, if Loadflow results are being displayed then two options are available, whilst Protection results give rise to
three options. Selecting one of these options will load the results / data directly into the application that has been
associated with comma separated variable files (Excel or Lotus 123).
PROTECTION DEVICES
The maximum number of protection devices for the standard version of ERACS has been increased from 300 to 450.
PROTECTION RELAYS
It is now possible to describe a protection relay's characteristic curve using any user defined equation. Please refer to
the ERACS manuals for full information.
To interact with the protection module the equation must include the following symbols:
TS = Time multiplier setting or Time dial setting.
M = Multiple of setting (I/Is).
As an example, the IEC Standard Inverse characteristic would be defined using the following expression:
TS * ( 0.14 / ( M^0.02 - 1 ) )
In addition to the standard arithmetic operators, +, -, *, /, the following functions are also available:
^
Power operator.
()
Parentheses for grouping.
Abs
Returns the absolute value of its argument.
Exp
Returns the exponential of its argument.
Ln
Returns the natural log of its argument.
Sqrt Returns the square root of its argument.

Version 3.1.1 - Released 24/01/01
DELETING NETWORKS & STUDIES
The method used to delete networks and studies from your network databases has been modified, resulting in a speed
improvement of approximately 50%.
LIBRARY MANAGEMENT
The library functions have now been moved from the Tools menu to a main menu item called 'Library'. All features are
now available all of the time, even when no network window is open.
CUT ELEMENT
A Cut facility has been added to an element's right click pop-up menu.
EDITING ELEMENTS

ERACS Enhancements List

38

To edit an element, simply double click the mouse left button whilst the mouse cursor is over the element.
NETWORK PROPERTIES
To view / edit network properties simply double click the mouse left button whilst the mouse cursor is in not over an
element.
SELECTION BANDS
If you click on an element it will be enclosed by small green boxes indicating that it has been selected. Pressing the
delete key whilst an element is selected will instigate the element deletion procedure.
MOVING ELEMENTS
To move an element simply click the mouse left button on one of its hotspots and whilst holding the button down start
moving the mouse. The element will begin to move.
MOVING SUMMARY RESULTS BOXES
To move a summary results box, simply place the mouse cursor within the box. Press the mouse left button and whilst
holding it down move the mouse. Release the button once you are in the desired position.
SAVING GRAPHS AS BITMAPS
It is now possible to save Protection co-ordination plots, Transient graphs and Harmonic impedance plots as bitmaps.
The facility enables you to save the graphs and legend as a bitmap to the clipboard or to file. To use this facility, select
'Save Graph as Bitmap' from the popup menu presented when the mouse right button is clicked in the graph area.
TOOLBARS
Five new toolbars have been added. By default, these will appear the first time you launch ERACS. However, they can
be enabled / disabled by selecting the appropriate item from the View | Toolbars menu option, or, by clicking the mouse
right button whilst the mouse cursor is over one of the buttons. The toolbars provided are...
- VIEW: This toolbar includes two new buttons to show the drawing grid and enable snap to grid.
- ZOOM: This toolbar also includes two new buttons. One returns the network diagram to the normal 1:1 viewing
mode. The other toggles the Zoom Window On/Off.
- HELP: Like the first two this toolbar also contains two new buttons. These enable you to display the Technical Manual
and User Guide.
- CALCULATIONS: This toolbar contains a button for each of the calculation modules.
- RESULTS: This toolbar contains four buttons. The first is used to display previously selected element data. The second
will display selected results. The third will clear results or data. The fourth will display the data / results selection form.
RECENTLY USED DATABASE LIST
A list of recently used Databases has been added to the Database menu. This feature enables you to quickly open a
database that you had previously opened by simply clicking on the name in the Database menu. By default, ERACS will
allow a maximum of 4 entries. This can be changed by using the controls provided in the tab labelled 'General' given in
the Options dialog box found under the Tools menu.
AUTOMATIC NETWORK LOADING
A facility has been included to allow you to disable the feature whereby ERACS loads the network you last used. This
option can be toggled on / off by using the check box labeled 'Load Last Network' provided in the tab labeled 'General'
given in the Options dialog box found under the Tools menu.
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LIBRARY DATA EXPORT
A facility to export library data in comma separated variable format (CSV) has been included under the Library Menu.
This option allows library data to be exported, viewed/validated in tabular format and reports created in external
applications (e.g. Word and Excel).
NETWORK DATA EXPORT
A facility to export Network data in comma separated variable format (CSV) has been included under the File Menu. This
option allows Network data to be exported, viewed/validated and reports created in external applications (e.g. Word
and Excel).

Version 3.1.0 - Released 03/11/00
BLOCK SELECTION
It is now possible to block select an area of the network diagram following a Protection calculation and either copy the
selection as a bitmap, or, print the selection.
CALCULATORS
The following calculators have been added to ERACS and can be accessed via the Calculations option of the Tools
menu:
- Impedance converter: This calculator enables you to convert ohms to per unit and vice versa.
- Inertia Constant Calculator: This utility will calculate inertia constant, H.
- Transformer Impedance Calculator: Given the inter-winding impedances of a 3 winding transformer and the ratings of
each winding, this utility will calculate the individual impedances of each winding. These values may then be entered
into the ERACS library.
LIBRARY
A new model has been included in the library, which enables time variant functions to be represented by a multi-point
curve. In this first instance they can only be used to represent load torque variation profiles for induction generators.
However, it is envisaged that this facility will be extended to include time variant electrical loads.
SUMMARY RESULTS BLOCK
It is now possible to start the move operation for the summary results box by clicking the mouse right button whilst the
mouse is over the results block and selecting Move from a popup menu.
TRANSIENT STABILITY
An additional class of load torque variation has been included for induction generator events. You are now able to select
one of the multi-point load profiles entered into the library as a Time Variant Function.
VIEW MENU
Two new options called 'Busbar Identifiers' and 'Protection Device Identifiers' have been added to the View menu.
These enable you to easily show or hide all busbar or protection device identifiers.
SNAP ON GRID
A snap on grid has been included. This feature may be enabled by selecting Grid from the View menu. This feature is
primarily of use when creating new networks. It may however, be used on existing diagrams to retrospectively align
elements to the grid. But this may only be achieved by moving individual elements.
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ZOOM WINDOW
The zoom window includes a rectangular box that indicates the active area, that is, the area of the network that is
currently accessible in the network diagram window. This box is now shown in colour and when the mouse cursor
passes over the box, the cursor changes from a cross-hair to an arrow-head. To change the colour used to fill the box,
click the mouse right button whilst the mouse is over the box and select 'Change Colour...'. This will reveal the standard
Windows colour dialog enabling you to select the colour.
NETWORK DIAGRAM WINDOW
When an element hotspot has been encountered the mouse cursor changes from a cross-hair to an arrow-head.
Thereby providing a clear indication that a hotspot has been found and an operation is available via the mouse right
button popup menu.
NETWORK DIMENSIONS
The busbar and bus section limits of the extended version (previously 1000 and 350) have been increased to 1500 and
850 respectively.

Version 3.0.12 - Released 19/06/00
BUSBAR IDENTIFIERS
An option has been added to the busbar pop-up menu that enables the busbar identifier to be hidden / shown.
COPYING THE NETWORK DIAGRAM AS A BITMAP
When a network diagram is copied as a bitmap it is now possible to save it to file and to copy it in monochrome. Two
new buttons and a tick box have been added to the 'Copy as Bitmap' dialog which is shown when one selects 'Copy
Diagram as Bitmap' from the Edit menu or from the pop-up menu when a framed selection is made. Clicking the 'To
Clipboard' button will copy the selection to the clipboard and clicking 'To File' will send the selection to file. If the
Monochrome tick box is ticked then the bitmap is drawn in black and white.
NEUTRAL EARTHING SYMBOLS
If the synchronous machine includes a neutral connection then an earth symbol is shown attached to the generator.
Similarly the earthing connections for transformers have been extended to include an impedance symbol if the neutral
connection includes impedance. All of these features can be disabled by clearing the appropriate tick boxes found under
the Appearance tab of the Options dialog.
NETWORK OVERVIEW/ZOOM WINDOW
It is now possible to maximise and restore the zoom window.

Version 3.0.11 - Released 11/05/00
CALCULATION SETUP PANELS
It is now possible to overwrite existing studies. For example, you may have a spelling mistake in the title of a Fault
study. Previously if you corrected the mistake ERACS would have created a brand new study. Now ERACS will ask
whether you want to overwrite the existing study.
FAULT & PROTECTION
A tick box named 'Include Motors' has been added to the setup panels. When ticked the fault contribution from all
asynchronous machines will be included in the calculation. If it is not ticked then ALL asynchronous machine
contributions will be removed from the calculation. The radio group named 'Reactance Option' has been replaced by a
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drop-down box which includes a third additional option called 'Sub-transient'. Like the 'Transient' reactance option, the
'Sub-transient' option will only be enabled if at least one machine in your network has the Park's equation model
selected. When 'Sub-transient' is selected all synchronous machines that have library data configured as Park's
equations will have their impedance set to Rs + j.X"d. Where Rs = stator resistance and X"d = sub-transient direct axis
reactance.
LIBRARY KEY SELECTION FORM
The co-ordinates of the library key selection form are saved each time the form is closed. So that when it is reloaded
the form will return to its previous position.
LOADFLOW RESULTS
The busbar results now include the negative and zero sequence driving point impedances.
PROTECTION GRAPHS
When a set of graphs is saved, ERACS now includes the grid's style and axes units in the saved collection.
TAP CHANGERS
Following a Loadflow calculation all tap changers that have been locked out or have reached one of their limits are
highlighted on the network diagram. Also, the transformer windings that they are attached to are highlighted in the
Zoom window.

Version 3.0.10 - Released 06/03/00
BLOCK CUT
An option called 'Cut Selection...' has been added to the Frame operations pop-up menu to enable you to cut a selected
area of the diagram. When the option is selected, click and hold down the mouse left button and drag a dotted box
around the elements to be cut. On releasing the mouse left button all elements within the dotted box will be highlighted
and you will be requested to confirm whether you want to continue. If you accept the selected elements will be cut to
the clipboard for pasting into an ERACS network. Please note that any busbars with connections to busbars outside the
block will be copied.
DATE FORMAT
For printed network diagrams and printed graphs the date is formatted using the
specified under Regional settings.

system's "Short Date Format"

ELEMENT MOVE
A 'Move' option has been added to the element's right button popup menu.
HINT WINDOW
A Hint window has been added to the main network diagram, protection graphs, Harmonic impedance graphs and
transient graphs. In the main network diagram; if the mouse cursor is left over an element for a short period of time a
hint window will be displayed showing the elements identifier. In the graph windows; if the mouse cursor is remains on
a graph for a short period of time a hint window will be displayed identifying the selected graph and the x/y
co-ordinates.
MANUALS
A new item called 'Manuals' is available from the Help menu. On selecting this option your will be presented with three
further options to view the Demonstration Manual, User Guide and Technical Manual. If you have Adobe Acrobat Reader
installed on your machine, selecting one of these items will automatically start the reader with the appropriate manual
loaded. Please note that it will be necessary to download and install the manuals separately. To download the manuals
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connect to our ftp site (ftp://www.era.co.uk/eracs) and downloaded the file called EracsMan.exe. This is a self
extracting zip archive which contains the three manuals in pdf format. To install the manuals execute EracsMan.exe. By
default it will place the files in C:\ERACS\Manuals. The files must be placed in a sub-directory called Manuals, off of the
main ERACS directory. For example, if you have installed your from copy of ERACS in D:\ERACS then the manuals
should be extracted to D:\ERACS\Manuals.
PASTE
The paste option has been extended to the main 'Edit' menu.
PROTECTION SETTING DATA
CT saturation and Relay discrimination margins have been included in the relay setting data written to comma separated
variable file.
SAVING LISTING FILES
A 'Save' button has been added to the form used to display study listings. This button enables you save the study listing
to file.
TRANSIENT STABILITY
GE's LM2500 Gas turbine model has been included for those users that have the appropriate license.
ZIP DATABASE
All libraries are now included with the network database when the 'Zip Database' option is selected.

Version 3.0.9 - Released 01/11/99
SWITCHES
When a Switch is highlighted in the main network window, either using the 'Find Element' or if operated during
protection co-ordination, the element that the switch is connected to is flashed in the Zoom / Thumbnail window.
Thereby highlighting the location of switch in the network diagram.
DIAGRAM MOVE
An option called 'Move Diagram...' has been added to the Edit menu and Network right button pop-up menu to enable
you to move the diagram. When this option is selected a dotted box is drawn from the top left-hand corner to the
bottom right hand corner of the diagram work space. All elements in the network will be highlighted and you will be
requested to confirm whether you want to continue. If accepted the dotted box will be displayed which you will be able
to move. To move the box place the mouse cursor in the box, then click and hold down the mouse left button. Now
move the mouse to place the box in the desired position. On releasing the mouse left button a pop-up menu with two
options will be displayed. To complete the move select 'Finish Move'.
BLOCK MOVE
An option called 'Move Selection...' has been added to the Frame operations pop-up menu to enable you to move a
selected area of the diagram. When the option is selected a dotted box is drawn from the top left-hand corner to the
bottom right hand corner of the diagram workspace. All elements in the network will be highlighted and you will be
requested to confirm whether you want to continue. If accepted the dotted box will be displayed which you will be able
to move. To move the box place the mouse cursor in the box, then click and hold down the mouse left button. Now
move the mouse to place the box in the desired position. On releasing the mouse left button a pop-up menu with two
options will be displayed. To complete the move select 'Finish Move'.
REFERENCE LIBRARY
We have included a new reference library which addresses some issues with protection device data. This library is called
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ERA_Reference_Library and is located in the directory called Libraries off of the main ERACS directory. We have made
this library read only with the intention that users cannot edit it since we will be updating it at future releases. Please
note that you will be able to copy keys from it and of course reference keys from it. We suggest that if you wish to use
keys from it that you copy them to your own library.
ELEMENT COUNTS
The maximum number of each type of element has been included on the 'Element Count' tab of the network properties
form.
PROTECTION
The protection co-ordination program now provides a feature that enabled relays whose CT have become saturated to
be highlighted. This feature is available from the Device Summary form displayed at each stage of a protection study.
SHUNT LOADS
We have added local multipliers to all shunt loads. These multipliers enable you to scale load parameters by a fixed
amount. For example for loads of type MW/MVAr two multipliers are provided, one to scale the MW value and the other
the MVAr value.
TRANSIENT GRAPHS
A facility has been added that enabled individual plots to be rescaled. Once a study is complete try clicking the mouse
right button in the graph region. In the resulting pop-up menu select 'Re-scale'. A form with two tabs will be displayed.
That labelled 'Axis' enables the maximum and minimum values of the axis to be modified. That labelled 'Plot' enables
you to adjust individual plot maxima and minima.

Version 3.0.7 - Released 07/07/99
PROTECTION DEVICE CHARACTERISTICS
A new option has been added that enables up to five Load lines to be included on pre-study protection device
characteristics. From the edit menu of the protection device characteristics form select 'Load Lines...'. Enter a value in
Amps and click OK. A green line will be drawn. Try placing the mouse cursor over a line (fault or load) or graph and
clicking the mouse right button. A popup menu appears from which you can change settings etc. We have also added a
label displaying the current in Amps to the top of each fault and load line. If one of the graphs selected has both phase
and earth elements have a look at the Graph menu. Two new options are available: 'Hide Phase Curves' and 'Hide Earth
Curves'. If 'Hide Phase Curves' is selected the phase curves for each IDMTL relay will be hidden and the 'Hide Earth
Curves' option will be disabled. If 'Hide Earth Curves' is selected the earth curves will be hidden and the 'Hide Phase
Curves' option will be disabled.
HARMONIC IMPEDANCE GRAPHS
We have added the facility that enables you to set the number of intervals on both the x and y-axis of the graph. In the
window that displays the harmonic graph, click the mouse right button. Select 'Rescale...' from the popup menu. The
form that is displayed has been divided into two groups; one for each graphical axis. Each group contains controls to
specify the maxima, minima and number of increments.
HARMONIC INJECTION
We have added the following busbar results: 'Voltage (V)' and 'Voltage (% of Loadflow Voltage)'.

Version 3.0.6 - Released 08/06/99
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LOADFLOW
Following requests from users we have extended the range of shunts to include Constant Current shunts and a new
class of Special Shunt. The Constant Current Shunts can be specified in either Amperes or kilo-Amperes. They maintain
constant current down to 0.5 p.u. in Loadflow. Below 0.5 p.u. voltage they become fixed impedance where the
impedance is 'frozen' at that value which would give target current at 0.5 p.u. voltage. The class of Special Shunt was
created for a specific customer and instances of this class cannot be created by other users. However, we have
designed the software to be extensible in this area and would be interested in your views as to whether or not other
shunt characteristics would be of interest to you. Whilst carrying out this work we also improved the way PQ shunts are
handled. They now maintain constant current down to 0.8 p.u. in Loadflow. Below 0.8 p.u. voltage they become fixed
impedance where the impedance is 'frozen' at that value which would give target current at 0.8 p.u. voltage. As before,
all shunts are fixed at their loadflow impedance values for the other calculation engines.
PROTECTION LINKS
A table listing the switches controlled by each operational relay is written to the Protection Setting comma separated
variable (CSV) file.
WINDOW MANAGEMENT
It is no longer possible to move a network diagram window over the main ERACS application window. Also, as the main
ERACS application window is moved the network diagram windows, results listing windows and graph windows are
moved relative to it.

Version 3.0.5 - Released 27/05/99
REINSTATING DELETED OR MODIFIED LIBRARY KEYS
When a library key is deleted or modified a copy of the original data is maintained so that it is still available to networks
that were constructed before the key was deleted or modified. When a network is loaded that contains such keys
appropriate warnings are issued. If an element that uses such a key is edited the library data is highlighted in Red. Up
until now you could still use the data but could not reinstate the key. A button labeled 'Reinstate...' has been added to
the library key selection window, which enables you to reinstate, deleted or modified keys. To reinstate a key, edit an
element that uses a deleted or modified key. Press the Select button. In the bottom right hand corner of the window is
the Reinstate button. Click Reinstate. A form displaying the library data is shown. If the key had been deleted then
there is no need to change the key's name. If the key has been modified then you will have to give the key a unique
name. Click the OK button and a new key will be added to the library and referenced by the element.
RESULTS LISTING WINDOW
Added a right button popup menu. This allows the standard editing functions to be performed on the data shown in the
window. Please note that the changes made are not saved back in to the ERACS database.
LOADFLOW PARAMETER DEFAULTS
A button labeled 'Default' has been added to the Loadflow Parameters tab of the network properties form. This button
returns all controls on the tab to their default values.
VIEWING LISTING FILES
The window used to display listing files is now associated with an open network window and has been made non modal.
This enables you to view a listing file for each network you have open and switch between a listing window and the
network diagram. For example if you opened two windows on separate data states of the same network you could
display the Loadflow listings of each state simultaneously.
WINDOW MANAGEMENT
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All windows have been modified so that they do not obscure the main ERACS window when they are maximised. Should
you find a window that does obscure it please let us know.
PRINT PREVIEW
Button icons have been made consistent with rest of suite and a 1:1 zoom button added.
LIBRARY KEY SELECTION WINDOW
The library key selection window (displayed when the Select button is clicked) now automatically highlights the library
key being used.
SINGLE/MULTI USER LOGON FORMS
It is now possible to hit the return key after specifying user name and password to accept input and start the ERACS
session.
IDMTL RELAY DATA ENTRY FORM
The positions of the Yellow phase and Blue phase selection boxes has been inter-changed.
LIBRARY MANAGEMENT FORM
Shunt types have been divided into 5 subclasses: 'Fixed PQ', 'Fixed Impedance', 'Fixed Admittance', 'Constant Current'
and 'Special'. The last two options will be populated at a future upgrade.
PROTECTION PLOTS
The width / weight of the axis, background grid and graph has been changed so that the graph is made more
prominent.
HARMONIC INJECTION RESULTS
For Busbars, 'Total Harmonic Distortion' has been renamed 'Total Harmonic Voltage Distortion' and the symbol changed
from 'TD' to 'TDv'. For all other elements, 'Total Harmonic Distortion' has been renamed 'Total Harmonic Current
Distortion' and the symbol changed from 'TD' to 'TDi'.

Version 3.0.4 - Released 23/04/99
MAXIMISING WINDOWS
The program has been modified so that the majority of windows that can be maximised are prevented from obscuring
the main network window.

Version 3.0.3 - Released 15/04/99
ELEMENT DATA ENTRY FORMS
A field has been included in the data entry forms for elements that use library keys indicating whether the key is
contained in the 'Working' or 'Reference' libraries.
PROTECTION CO-ORDINATION
At the end of each stage Total and Stage times are included in the message sent to the monitor window.
PROTECTION DEVICES
When a Protection device is highlighted in the main network window, either using the functions, 'Find Element' or
'Change Device Viewing Status...', the element that the device is connected to is flashed in the Zoom / Thumbnail
window. Thereby highlighting the location of selected devices.
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Version 3.0.2 - Released 12/03/99
TRANSIENT
A grid has been added to the graph.
TRANSIENT
Selected print times are automatically sorted into ascending order.
PROTECTION
Device characteristics window. Time and current at the mouse position are reported in the second panel of the window's
status bar.
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